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Micro Focus Academic Program 8.0 -
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Overview

The Micro Focus Academic Program brings contemporary software development tools and technologies to
COBOL development helping to bridge the gap between the old and the new.

COBOL applications still run many of the world’s business systems, therefore teaching the COBOL
language is a great way to prepare your university's students for a robust IT career in today’s economy.

The Micro Focus Academic Program is designed to support the education and use of the COBOL language
within the academic setting. This program supports our academic partner community through the use of
our COBOL development tools and materials within the classroom.

This program will enable your university to quickly join this growing league of similar academic
organizations in support of the promotion and education of the COBOL language.

Welcome! We're excited to have you join our growing academic community.

Product Description

The Micro Focus Academic Program Edition package comprises the following products:

« Visual COBOL - delivers the richest development experience for COBOL programming. On Windows,
Visual COBOL is available for use with Microsoft's Visual Studio or with the Eclipse integrated
development environments. On UNIX or Linux, it is available for use with Eclipse. Visual COBOL
supports the development and deployment of both JVM COBOL and .NET COBOL, and of native
COBOL applications.

Variants of Visual COBOL include:

* Visual COBOL for Visual Studio 2017, Visual Studio 2019, or Visual Studio 2022
« Visual COBOL for Eclipse (Windows)

« Enterprise Developer - a contemporary development suite for Microsoft Visual Studio or for Eclipse that
enables mainframe developers to maintain, develop and modernize mainframe applications regardless
of whether these are to be deployed back on the mainframe or onto an alternative platform. Enterprise
Developer supports IBM COBOL, IBM PL/I, IBM Assembler, IBM CICS, IBM IMS, IBM JCL, IBM DB2,
IBM z/OS file formats and common batch utilities including SORT. This means you can develop and
maintain the core mainframe online and batch applications under Enterprise Developer, then deploy
them back on the mainframe or migrate them onto one of the Micro Focus production platforms
available on UNIX, Linux, or Windows. Variants include:

« Enterprise Developer for Visual Studio 2017, Visual Studio 2019, or Visual Studio 2022
« Enterprise Developer for Eclipse

Micro Focus Academic Program differs from the full version of these products in a number of ways. The
differences are:

* You cannot deploy applications on other machines, so Micro Focus COBOL Server and Enterprise
Server are not supplied.

« Alicense for the Micro Focus Rumba 3270 terminal emulator is not supplied.
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Note: Micro Focus Academic Program is supplied for Academic use only. It is not to be used for any
commercial purposes. You must be a registered Micro Focus Academic Program Partner in order to
use this software.

For more information, follow the link in the Electronic Product Delivery email for the End User License
Agreement.

Reporting Issues

* For the latest information and discussions on this product, or to report issues, visit the Micro Focus
Community Web site.

f Note:

» This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

¢ Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.

If you are using Eclipse, Visual COBOL can automatically relink existing projects created with Visual
COBOL earlier than 4.0 that have executable link artefacts. Eclipse displays a warning in the Problems
view that the project requires relinking. It then offers a Quick Fix action for you to execute that will link your
project with the most recent version of the Run-Time System.

What's New

This What's New? document covers some of the new features and functions in the latest release of the
Micro Focus Enterprise Product Suite. Updates apply to the following products:

* Micro Focus Enterprise Developer which provides a contemporary development suite for developing
and maintaining mainframe applications, whether the target deployment is on or off the mainframe.

* Micro Focus Enterprise Test Server which provides a comprehensive test platform that takes
advantage of low cost processing power on Windows environments, to supply scalable capacity for
testing z/OS applications without consuming z/OS resources.

Micro Focus Academic Program 8.0 - Release Notes | 5
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* Micro Focus Enterprise Server which provides the execution environment to deploy fit-for-purpose
mainframe workload on Linux, UNIX and Windows (LUW) environments on IBM LinuxONE (IFLs),
standalone servers, virtual servers, or the Cloud.

* Micro Focus Enterprise Server for .NET which provides the execution and modernization platform to
deploy fit-for-purpose mainframe workload on a scale-out .NET infrastructure and the Azure Cloud.

This document helps you to quickly understand the new capabilities within the 8.0 release.
Enhancements are available in the following areas:

» Micro Focus COBOL Extension for Visual Studio Code
* Micro Focus Enterprise Extension for Visual Studio Code
* .NET 6 Support

» Application Workflow Manager

e CICS Support

e COBOL Language Enhancements

* Code Analysis

e Compiler Directives

» Data File Tools

» Debugging

» Eclipse Integration

» Enterprise Server

« Enterprise Server Common Web Administration
» Enterprise Server Security

e JCL Support

» Micro Focus Database File Handler

¢ Micro Focus Unit Testing Framework

¢ Open ESQL

e PL/I Support

e Terminal Emulation

¢ Visual Studio Integration

Micro Focus COBOL Extension for Visual Studio Code

Back to Top
The Micro Focus COBOL extension for Visual Studio Code provides the following enhancements:

* The use of the Micro Focus COBOL extension with Visual COBOL 8.0 or Enterprise Developer 8.0
installed on the same machine enables COBOL Language Server support. This offers a rich COBOL
editor experience inside Visual Studio Code including IntelliSense, Peek Definition, and Rename.

Note: The Micro Focus COBOL extension is available from the Microsoft Visual Studio Marketplace -
click here.

Micro Focus Enterprise Extension for Visual Studio
Code

Back to Top
The Micro Focus Enterprise extension for Visual Studio Code provides the following enhancements:

* The use of the Micro Focus Enterprise extension with Enterprise Developer 8.0 provides PL/I editor,
compiler and debug support. The PL/I debug support includes data breakpoints, conditions, and
signals.

Micro Focus Academic Program 8.0 - Release Notes
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Note: The Micro Focus Enterprise extension is available from the Microsoft Visual Studio Marketplace
- click here.

.NET 6 Support

Back to Top
This release provides the following enhancement:

* You can create, build and run COBOL projects targeting .NET 6 in Visual Studio 2022. In all other
supported environments, you can use the .NET 6 SDK or Visual Studio code to build .NET 6 COBOL
projects.

Support for .NET Core 3.1 has been discontinued.

Application Workflow Manager

Back to Top
This release offers the following improvements:

* A new "Select Element List" button in the action bar of the Table Results view enables you to directly
select an existing list. Navigation in the history using the backward and forward arrows is now per
Eclipse session.

* A new relationship for an action, Create Element List.

* A new JES function package - enables you to define tools in an AWM model to browse, cancel, or
delete z/OS jobs.

e The IDz Function Package Tools now support the new tool interface introduced with release 5.0.

* A new Filter Data Tool in the AWM function package.

CICS Support

Back to Top

This release introduces the following new features in Eclipse:

* A CICS Resources context menu command for CICS-enabled native enterprise server regions in
Server Explorer - enables you to manage the PCT, FCT, and PPT resources.

« Enterprise Server validation in the IDE for CICS Web Services.

* Reports validation errors where the associated enterprise server region configuration requires
adjustments to support the CICS Web service.

< Enables you to change the current configuration of the enterprise server region.

< Validates that the enterprise server region supports the CICS Web service when all validation errors
are resolved.

COBOL Language

Back to Top
The following enhancements have been made to the Micro Focus COBOL language:
* Further support for IBM Enterprise COBOL 6.3:

e JSON PARSE and JSON GENERATE statements - for JSON GENERATE, anonymous objects can
be generated using the OMITTED key word; the SUPPRESS phrase has been enhanced; the
CONVERTING phrase is supported. For JSON PARSE, anonymous objects can be parsed using the
OMITTED key word; the CONVERTING phrase is supported.

Micro Focus Academic Program 8.0 - Release Notes | 7
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» Intrinsic functions - the following list of functions is now supported: COMBINED-DATETIME,
FORMATTED-CURRENT-DATE, FORMATTED-DATE, FORMATTED-DATETIME, FORMATTED-
TIME, INTEGER-OF-FORMATTED-DATE, SECONDS-PAST-MIDNIGHT, SECONDS-FROM-
FORMATTED-DATE, TEST-FORMATTED-DATETIME, and UUIDA4.

« The AMODE Compiler directive has been enhanced to allow COBOL programs full access to the 64-
bit address space (AMODE"64"). This emulates the LP"64" option in Enterprise COBOL.

« The DYNAMIC LENGTH clause, introduced in the last product release, is now supported in .NET
COBOL and JVM COBOL (as well native COBOL).

« JVM COBOL.NET COBOL enhancements:

* When no explicit type is declared for a variable, but the value is a non-integer numeric (for example
declare varl = 1.23),itis assumed to be of type float-long.

« The NAME OF expression has been introduced. It returns the unqualified name of the type or
member specified.

Code Analysis

Back to Top

The Application Analysis Server enables you to access either Micro Focus Enterprise Analyzer or COBOL
Analyzer from the IDE. This release includes the following enhancements to this feature:

« A generate code search report and a single code search reports are available.
« Animproved Get Direct References report.

Enhancements to the Analysis Services include:

* An enhanced Program Flow Graph

e Support for displaying the Data Flow analysis as a Graph.

* A new Eclipse preference page, Application Wide Knowledge in Window > Preferences > Micro
Focus > COBOL > Code Analysis. This enables you to adjust certain timeout settings for certain long-
running queries executed against a remote Enterprise Analyzer or COBOL Analyzer server.

Enhancements in the Rule-Based analysis include:

* The Micro Focus Code Analysis project's properties page in Visual Studio, and the Micro Focus
Code Analysis Manager dialog box now support subfolders in the rulesets.

* The Rules preference page in Window > Preferences > Micro Focus > COBOL > Code Analysis
now supports nested rules.

Compiler Directives

Back to Top

The following Compiler directive is new in this release:

» DISPLAY-PICU - defines the way PIC U data items are displayed: either as ANSI or UTF-8.
The following Compiler directive has been enhanced in this release:

* AMODE - a new parameter "64" stores pointers in 64-bit format - see COBOL Language Enhancements
for more details.

Data File Tools
Back to Top

The following enhancement has been made to the Data File Tools:

Micro Focus Academic Program 8.0 - Release Notes



The Data File Editor now supports opening and editing KSDS VSAM files stored in an MFDBFH
datastore.

Debugging Applications

Back to Top

This release includes the following enhancements:

Locals window support for native COBOL in Visual Studio - during debugging, the Locals window now
displays the names of the variables available on the current statement.

In Eclipse, the Enterprise Server debug configurations can now configure the Program breakpoint on
main entry point only option, which if selected, only breaks execution when the Procedure Division
entry point is called.

Eclipse

Back to Top

Enhancements are available in the following areas:

Product:

Visual COBOL for Eclipse is now available on Linux platforms. Includes features such as:

» Building and debugging of mainframe COBOL projects

e Support for PL/I background parse, running and debugging

* CICS Web services

» Server Explorer

e IMS support for PSB, DBD, and MFS Files

» Data File Editor

« Code analysis using the Application Analysis server

This release supports Eclipse 4.20 (2021-06), which is shipped and installed with Visual COBOL.
Versions of Eclipse prior to this one are not supported.

Projects:

Apache Maven support - native COBOL and native COBOL Unit Testing projects can be incorporated
into your Maven-based lifecycles. They now accept a pom.xml file, which can be configured to run the
Maven AntRun plugin, which allows Ant-based projects to work with Maven.

Automatic directives determination - it is now possible to specify if this should run and if you will be
prompted to perform it from Perform automatic directives determination preference, available from
Window > Preferences > Micro Focus > COBOL|PL/I > Directives Determination.

Code Clean Up - you can configure code clean up preferences, which you can apply to your code to
ensure consistency throughout your COBOL code (for example consistent use of the PIC or PICTURE
keyword). These preferences are stored in profiles, which allows them to be shared among
development teams.

Multi-file compilation - right-click a selection of files, and click Compile when Automatic Build is
disabled. This utilizes the Maximum compilations/links to execute concurrently option (available
from Window > Preferences > Micro Focus > Builder > Project) for native COBOL projects.

Order of the Dependency Paths or Copybook Paths list - it is now possible to control the initial position
of the new directory in the list. Use the Insert to the beginning of dependency paths list/Insert to
the beginning of copybook paths list or Append to the end of dependency paths list/Append to
the end of copybook paths list options to determine the position. These options are available from
Window > Preferences > Micro Focus > Builder > Project.

COBOL Editor:

Micro Focus Academic Program 8.0 - Release Notes | 9
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e COBOL code mining - code minings are additional content shown in the COBOL editor to give extra
context to certain code elements. Use the Window > Preferences > Micro Focus > COBOL > Editor
> Code Minings page to enable an indicator showing the number of times that a section or a paragraph
is called in your native or procedural JVM COBOL code. Select the link shown to show a list of
references in the Search view, where you can use the matches shown to jump to the actual call within
your code.

* end- delimiter tooltips - within the COBOL editor, if you hover over the end- delimiter of a statement
such as an IF or an EVALUATE statement, a tooltip showing the opening clause of the statement is
displayed. You can enable/disable this behavior from the Block matching section in the COBOL editor
preferences.

Enhanced BMS tools integration with Eclipse on Windows and Linux:

* A BMS Preview view inside Eclipse enables you to preview the BMS screens on Windows and now on
Linux where the standalone Micro Focus BMS Painter utility is not supported.

To invoke the preview, open a BMS file in the editor and click Toggle the BMS previewer view in
the Eclipse toolbar.

« The BMS text editor in Eclipse now offers enhanced writing support with smart editing and smart tabs,
smart Home/End caret support, collapsible sections in the BMS code, and initial syntax checking and
error reporting on background parse.

* The tree structure inside the Outline and Program Outline views now includes the mapsets and maps,
and any macro attributes and strings. Hovering an element in the views shows their properties.

* Enhanced navigation - when you navigate inside the BMS source file, the relevant fields in the BMS
Preview view are highlighted. The same fields are highlighted in the tree view inside the Outline and
Program Outline views and this works both ways - clicking on any of the nodes in the tree view
highlights the line in the editor that includes the relevant field.

Enterprise Server
Back to Top

This release provides enhancements in the following areas:
» EZ Sockets now supports up to 4096 sockets on Linux, up from 1024, and enhanced tracing.

» EZ Sockets applications, including ones that use the CICS listener CSKL (EZACIC02), can have
more simultaneous connections.
* EZ Sockets tracing now has options for logging the recent history only when any error or one of a set
of particular errors occurs. This makes it easier to use tracing to diagnose EZ Sockets issues.
« Enterprise Server dataset management - dataset maximum retention period with the ability to alter and
create reports:

e ES JES ENFORCE_EXPIRE_DATE - helps determine whether or not to check the expiration date
when deleting a catalogued dataset, and if expired, delete the dataset. If it hasn't expired and the
PURGE option has not been specified, the dataset is not removed. The PURGE keyword is required
to delete non-expired datasets. PURGE removes the underlying physical dataset file unless it is
referenced by another catalog entry. SMS MANAGEMENTCLASS now supports maximum RETAIN
days. See Using SMS MGMT Classes and the %SMS example command in the same topic.

e ES JES LISTCAT_YMD - helps determine the date format used in the HISTORY report generated
when the IDCAMS LISTCAT command specifies the ALL option.

« The EXPDT entry in a DD statement must be a four-digit year (YYYY); otherwise 1900 is the default,
which is in-line with the mainframe processing, and prevents unexpired datasets from being
erroneously removed (as was the case with the previous default of 2000). The ALTER command now
takes the TO and FOR options to enable specification of the retention period for the entry being
altered. The maximum retention period might be limited by the management class. The IDCAMS
LISTCAT command ALL parameter now generates a separate HISTORY report that shows the
creation date time and job, the last changed date time and Job, and the expiration date.

Micro Focus Academic Program 8.0 - Release Notes



HTTP compression - the Communications Server supports compressing large HTTP responses with
gzip, and handles gzip-compressed HTTP requests. The Common Client supports gzip-compressed
HTTP responses. Some large HTTP responses are compressed automatically if the client supports it.
Large HTTP messages can be compressed, saving network bandwidth and improving performance.
Task-cleanup performance - the performance of post-processing for tasks in MFCS has been improved.
ICETOOL emulation - now supports the COUNT+n and COUNT-n syntax during trailer processing,
where n is a numeric between 0-999. This adds to or subtracts from the COUNT value.

DSNRLI now implements one-phase commit optimization where appropriate.

Listing DEQ errors - a new caspac action, CasDEQs, enables you to list all errors that might have
occurred on DEQs either at the end of a task or while a job or a transaction was executing.

Enterprise Server configuration - you can now change the recording directory of the dump, trace, HSF,
and the console. log files of each region. See Alternative Enterprise Server Output Locations for
more information.

CICS API support - the CICS APl GET CONTAINER option BYTEOFFSET is now supported.
Compression on ECI calls via CASBNCCL Client - when using the Micro Focus External Call Interface
(ECI) over TCP/IP, the request and response data flows are now compressed using RLE.

Enterprise Server Common Web Administration
(ESCWA)

Back to Top

This release includes the following enhancements:

Oracle Coherence is now available as a PAC Scale-Out repository as an alternative to Redis.

Reduced number of Redis instances required when a PAC incompatible upgrade is performed - it is now
possible to have multiple PSORs in one REDIS instance. This allows for the REDIS instances
provisioned in the PAC to be reused.

Enhanced PAC diagnostics via CTF - a new option on the ES Control page is now available to enable or
disable CTF for a running region without the need to recycle the region.

ESCWA API, version 2 - includes updated versions of some of the existing API, version 1 endpoints,
with improved JSON property names, more sensible URIs. The version 2 APl is a single API standard
across API endpoints. It includes a number of usability enhancements, has a better readability and
discoverability, and includes an improved API documentation.

Enterprise Server Configuration Manager

« A variety of configuration options are available in ESCWA on the General >Advanced page for a
region.

The property grid in ESCWA shows the full list of configurable properties, categorized by group,
along with help text and some additional meta-information. Properties marked as dynamic in the
property grid can also be updated in a running region.
« A number of properties that were previously set with environment variables are now available in the
ESCWA Ul. The environment variables are still supported for backward compatibility.
Accessibility enhancements - the ESCWA Ul includes a number of improvements in the areas of
usability with screenreaders, color contrast, and text and icon sizing and alignment. This is to give it an
improved compliance with the 508 and WCAG 2.1 standards.

Enterprise Server Security
Back to Top

This release includes the following enhancements:

AWS Secrets Manager - support is available for using an AWS Secrets Manager, mfsecretsaws, as a
remote vault. See The mfsecretsaws Vault Provider .

Micro Focus Academic Program 8.0 - Release Notes
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Protection for sensitive data - some sensitive data is now protected in the memory. This helps reduce
the risk of exposing sensitive data such as passwords in core dumps and similar scenarios.

An option to update short names - the ESF Update mechanism enables you to change between OS
users ("long names") and ES userids ("short names") in running regions. This requires a non-default
configuration setting.

Caching improvements - ESF caching now caches more types of requests. This helps improve the
Enterprise Server latency and throughput when external security is configured with caching.

Support for Argon2 in password history - when Micro Focus passwords are used with the MLDAP ESM
Module and password history is enabled, use Argon2 password verifiers in the history to avoid the
potential exposure of passwords via weaker verifiers. This helps improve the security of the password-
history mechanism.

The product Help includes a new section, Securing Enterprise Server, which provides guidance on
improving the security of Enterprise Server installations and the applications they host. This includes
information on security and how to reduce security exposure.

Interface Mapping Toolkit

Back to Top

This release includes the following enhancement:

Support has been added to Visual COBOL for Eclipse on Windows and UNIX for creating JSON
(RESTful) Web Services using API resources. See JSON (RESTful) Operations in your product Help for
details.

JCL Support

Back to Top

This release provides the following enhancements:

In Eclipse, a Show Spool and a Show Catalog context-menu command are available in Server
Explorer for MSS-enabled enterprise servers. These enable you to display and manage the regions'
JES spool queues and catalogs, respectively.

Support is available for the DSENQSHR JOB statement parameter with options of ALLOW, USEJC, and
DISALLOW. You can configure the use of this parameter with the new ES_DSENQSHR environment
variable for Enterprise Server.

The Micro Focus Database File Handler
Back to Top

This release includes the introduction of the Micro Focus Database File Handler (MFDBFH) for Visual
COBOL. MFDBFH enables you to store your data files within one of the supported relational database
management systems, which can be used by your native COBOL applications.

Data files are stored in a 'datastore’. Datastores can each be housed in their own physical database, or
one database can house many datastores. Using data stores gives you the performance and resilience
benefits associated with a modern RDBMS. MFDBFH does not require you make any changes to your
source code in order to use it.

This feature is available as a purchasable add-on.

The Micro Focus Database File Handler in Enterprise Developer offers the following enhancements:

PostgreSQL and Microsoft SQL Server now support storing datastores, region databases, and cross-
region databases in a single physical database, instead of storing them in separate databases.
Configurations that use a single physical database can now use a single database connection to access
all MFDBFH resources stored within.

Micro Focus Academic Program 8.0 - Release Notes



Micro Focus Unit Testing Framework
Back to Top

The following enhancement has been made to the Micro Focus Unit Testing Framework in the IDE:
» IDE support has been added for self-contained tests.

The following enhancement has been made to the command-line version of the Micro Focus Unit Testing
Framework:

« You can now use the Micro Focus Unit Testing Framework to build and run test cases from within
a .NET 6 environment. Install the NuGet package supplied with Visual COBOL to enable the mfunit
extensions to the dotnet command line utility.

OpenESQL

Back to Top
This release includes the following enhancement:

« The new SQL Error Mapping feature enables you to customize how error information is returned in
SQLCODE, SQLSTATE, SQLERR and MFSQLMESSAGETEXT. For details, see SQL Error Mapping in
your product Help.

PL/I Support

Back to Top

Enhancements are available in the following areas:
PL/I compiler compatibility:

Support has been added for the following:

« Decimal Floating Point (IEEE-754-2008) when running on Intel architectures. This enables data to be
held in Densely Packed Decimal (DPD) format or in Binary Integer Decimal (BID) format. This feature is
in Early Adopter Program (EAP) release status.

* NOEXECOPS when running under the control of JCL.

e PL/I built-in functions including: ENDFILE, EPSILON, EXPONENT, ISFINITE, ISINF, ISNAN, ISZERO,
MAXVAL, MINVAL, PLACES, PRECVAL, PRED, RADIX, ROUNDAWAYFROMZERO, ROUNDTOEVEN,
SCALE, SQRTF, SUCC, and XMLSCRUB.

* The IEEE attribute on a FLOAT DECIMAL variable declaration.

PL/I compiler listing enhancements:
PL/I compiler listings now include:

« Display of options in effect and option defaults
* Unreferenced variables
e The OPTIONAL attribute for parameters

PL/l debugging:
PL/I debugging now supports:

* Hardware breakpoints in the IDE.
* STEP out of a CICS LINK level
* Much larger call stacks

PL/I debugging in Visual Studio has been enhanced as follows:

Micro Focus Academic Program 8.0 - Release Notes
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« The debugger operates with PL/I code just as it does with other languages such as COBOL. The
following features are included to enhance the PL/I debugging experience:

* Add, modify, and delete monitors on PL/I signals and conditions

* The Wait for debuggable attachment feature enables you to use the PLITEST() API in conjunction
with the "wait for attach with ID" mode.

« The setting of key/value pair environment variables in project properties
PL/I EXEC Preprocessor:
« Early adopter support for an EXEC SQL statement that specifies a compiler-generated exit.
PL/I Macro Preprocessor:

¢ COMPILETIME/COMPILEDATE builtin functions now output without %SDEBUG/%RDEBUG pairs
* New GETENYV built-in function

e Support for CALL within a PL/I Macro

» Support for ITERATE, DEPRECATE, DEPRECATENEXT

PL/I Run-Time System:

* Improved performance of JSON builtin functions

* Improved PLIDUMP callstack accuracy on the newest Redhat and SUSE releases

» PLIDUMP Display of the offset within prologue code a signal is received within the prologue of a PL/I
Procedure

« FIXEDOVERFLOW generated upon assignment to FIXED DECIMAL variables where truncation occurs
» Support for NOEXECOPS when running under the control of JCL
¢ PLIHSSR now allows for use of PCB in addition to PCB Pointer in call

Terminal Emulation
Back to Top

« This release installs the Session Server component of Micro Focus Host Access for the Cloud
(HACloud). HACloud provides browser-based HTML5 access to 3270 host applications on Windows
and Linux for multiple connected users. HACloud is configured to work out-of-the-box with the default
configuration for ESCWA and MFDS and might need to be configured before you start using it.

Visual Studio

Back to Top

e Support is now available for Visual Studio 2022.

« Syntax coloring for COBOL in the editor had been improved for identification divisions, copybooks
references using COPY... REPLACE statements, and EXEC blocks.

Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Case Number followed by the Defect number (in
parentheses).

e Code Analysis
«  Common Communications Interface
e Compiler
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Containers

Eclipse IDE

Enterprise Server

Machine Administration

Mainframe Access

File Handling

JCL Support

Micro Focus Batch Scheduler Integration
Micro Focus Communications Server
Micro Focus Directory Server

PL/I Support

REXX Support

Run-time System

SQL: OpenESQL

Code Analysis

Back to the list

Rules in nested folders are now correctly processed, as well as rules with the same name.

(207020)

Common Communications Interface

Back to the list

For improved security, SSL/TLS connections are now restricted to TLS versions 1.2 and 1.3 by default.
This is an industry best practice. If you need to use older, less-secure protocol versions with legacy
clients or servers you should consult the product online help for instructions on configuring TLS protocol

versions.
PSEC:103001 (87188)

Compiler

Back to the list

When a RELEASE or RETURN statement is executed in an input or output procedure of a sort
statement, if the SORT-RETURN special register is found to contain a value of 16, then the sort should
be aborted, even in a case where the RELEASE or RETURN statement is at a lower perform level than
the input or output procedure itself. Previously, this was not happening for programs compiled to JVM

or .NET COBOL, but this erroneous behavior is now fixed.

01723392 (104114)

When a variable is defined in a DECLARE statement with no explicit type, but a value that is a non-
integer numeric literal, the type is assumed to be float-long (i.e. a 64 bit floating point).

(148103)

Containers

Back to the list

The containers image build tool now supports custom Java run-times which helps to keep the size of

Java-based applications smaller.
(182004)
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Eclipse IDE
Back to the list

COBOL formatter functionality has been enhanced with the introduction of a ‘Code Clean Up' feature.
The code clean up preferences are stored in profiles, similar to the COBOL formatter preferences, and
are also applied in a similar way, within the COBOL editor. See Formatting COBOL code in the
documentation for more details.

(123034)

Enterprise Server

Back to the list

The Security Manager passwords no longer appear in the commonwebadmin. json configuration file.

(203052)
The X-XSS-Protection header will now be set on all requests instead of only on API requests.

01938835 (138176)
In ESCWA, the colors and contrast have been adjusted to improve visual accessibility.

01995403 (158071)

ESCWA now displays an improved message if there is an issue with loading the application, especially
in the case where there is a browser incompatibility.

(241013)
ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

00370773 (11742)

In ESCWA, the Console Log page now enables you to easily traverse and navigate the log. The new
paging feature uses an API call from the Communications Server group documented in the Enterprise
Server Administration Server API, typically located at http://1ocalhost:10086/docs/#/
Communications_Server on the machine where you have the product installed.

02085456 (191017)
ESCWA now supports multiple PACs in a single Redis store.

(248003)
ESCWA now handles enterprise server regions that use character encodings other than windows-1252.

(91001)
In ESCWA, the IMS MPR Processes table on the Monitor > SEPs page now displays the new IMS Type
and PROCLIM columns from MPR PWFI support.

(182066)
In ESCWA, on the Communications Process page you can now specify a Requested Status for the
communications process.

00669779 OCTCR50A69378 (69378)
In ESCWA, the CICS DCT resource now displays all fields regardless of the type. See Transient Data
Queue in your product Help for more information.

(173056)
In ESCWA, the Catalog DCB page now displays the file size in bytes.

01909652 (138002)

ESCWA now supports Circular Logging. On the Tracing and Logging Settings page you can now
specify the Log Max File Size and the Log File Count fields. By default, these fields are set to 1024kB
and 5 respectively. See Tracing and Logging Settings in your product Help for more information.

02083633 (191019)
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In ESCWA, a new optional Logon security resource has been added. This can be used to control
users' ability to log on. See Security Resources to Control ESCWA and API Access in your product Help
for more information.

01886579 (124022)
CICS THRESHOLDS now support IMS. Notes modified in the following three topics:CICS Defined
THRESHOLDThresholdActive Threshold

(246113)
You can now define and install shared SOR Models. In the SOR Model dialog box, check Shared to
enable the SOR Model to be shared between PACs.

(244088)
CICS Resources can now only be created via the group if they are appropriate for the functionality of
the enterprise server region.

01858819 (148068)

For LDAP-based security in Enterprise Server, the processing of password changes has been modified
to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)

Enterprise Server with LDAP-based security now denies a sign-on attempt by default if it includes a
password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)
A change has been made to the way that TS queues and TD queues are stored in a PAC. This was to
ensure that deleting a 0TSQ did not also delete all queues that had a 0TSQ__ name prefix.

f Note: After the update is applied you must cold start your PAC.

(183044)

In a PAC, the SIT setting is now honored when a TS or TD is to be applied to the enterprise server
region if the TS or TD is not under a SOR, MFDBFH, or Fileshare. This means that if a SIT has to cold
start for TS or TD and the files are either in the workarea or on disk then the SIT settings will be applied,
otherwise the PAC-wide settings will be applied.

02149316 (204020)
EZASOKET traffic will now be assigned to Communications Process instance #1. You might need to
consider this if you use load balancing.

02060014 (201009)

When a PAC is cold started, the configuration file specified by MFDBFH_CONFIG will be uploaded to
the PSOR and a temporary file created in the enterprise server region’s workarea. This temporary file
will be used by all the processes for that enterprise server region. Subsequent enterprise server regions
joining the PAC will then create a temporary file in its workarea for the MFDBFH_CONFIG from the
PSOR store. If an enterprise server region in the PAC is killed or is terminated abruptly than the restart
of the enterprise server region will try to recover the previous UUID left in the PAC and DEQ all
remaining ENQs in MFDBFH that were created from the previous run. New messages will be created in
the console. log identifying if the recovery was initiated and successful, if the enterprise server region
could not be recovered automatically, the region will stop. A log file will be created in the workarea with
the following file naming convention:

Caspac_Recover_UUID_XxXxXxxxxxxxxx . log

For example: CASCD4012W Region was not stopped properly, recovering previous region UUID
14BAAA87B4C010BFBDE278A5F65B350C 18:15:17CASCD40141 UUID recovery file log C:\Users
\mag . CORPDOM\Documents\Micro Focus User\Enterprise Developer\WORKAREA
\RAS1\Caspac_Recover_ UUID_ 14BAAA87B4C010BFBDE278A5F65B350C.1og 18:15:18. Using
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the caspac utility with the —aStatus parameter will display if the enterprise server region in a PAC has
lost its connection to the PSOR. If you determine that the region is no longer in the PAC, then you can
run the caspac utility with the —aRecoverUUID parameter to recover the enterprise server region. If
the —aRecoverUUID parameter is used, then a file will be created in the current directory with the
following file naming convention:

02081952 02123645 (182093)
Caspac_Recover_UUID_XXXXXXxXxXxxxX . log.

See caspac in your product Help for more information.

Functions have been added to file_utilities which check a given file name against either a default
blacklist containing operating system reserved file names, or a passed blacklist. Read, write, and delete
in AES and MSCPD use this function to disallow secret names which are inappropriate names.

OCTCR50A7844 (112022)
The default users are now able to access only the corresponding areas:

mfuser -- esmaccicsuser -- CICS and enterprise server region start and stop.
jesuser -- JES related operations and areas.imsuser -- IMS related operations and areas.

01990931 (138369)
Fileshare is no longer used to locate the Resource Definition and CNV file.

00468648 (69010)
MQ updates did not rollback on step failure. This has been fixed.

01976727 02161235 (155010)

PSOR stores are now prefixed by the PAC NAME and a version humber enabling you to run multiple
PACs in the same PSOR, simplifying the incompatible upgrade process. The caspac utility enables you
to add the PAC Name as part of the command line parameters using —-pPACName or if not specified
using the ES_PAC environment variable. See caspac in your product Help for more information.

(202162)
The XA reconnect mechanism now attempts to reconnect to all XA entries marked as "enabled" at the
start up of the enterprise server region. To prevent the reconnect attempts, do one of the following:

« Remove the XA manager from the enterprise server region definition.
» Set the XA manager as disabled before starting the enterprise server region.

01991481 02003277 (151008)

A new MLDAP ESM custom configuration section has been added. The [Prefix Search] option
enables the Prefix Search wildcard optimization for limiting the scope of wildcard resource entities
checked under a resource class. See MLDAP ESM Module Custom Configuration Information in your
product Help for more information.

00726158 (73180)

For LDAP-based security in Enterprise Server, the processing of password changes has been modified
to address security issues, inconsistencies among configurations, and other issues. See Understanding
passwords with LDAP-based security in your product Help for more information.

(118088)

Enterprise Server with LDAP-based security will now by default deny a signon attempt if it includes a
password-change request (a new password is supplied), and the password change fails. This was the
existing behavior in some configurations but not in others. It is now consistent and configurable. See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

(108046)

File Handling
Back to the list
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The connection registration process has been enhanced to rectify a problem where XA registrations
sometimes failed to register with MFDBFH in an Oracle RAC environment.

Note: This fix is dependent upon the Oracle XA switch module being recompiled with the latest XA
switch sources.

02214893 (246077)
SYMNAMES support has been added to the ON operand in the SELECT statement of ICETOOL.

02040047 (167028)

When using the SELECT operator of the ICETOOL emulation, a validation check has been
implemented to ensure that when making use of the DISCARD operand, the data set opened for output
does not have an LRECL greater than the LRECL that ICETOOL is expecting. If it does, the job will

fail. This check may now cause jobs that previously ran successfully to now fail, but this behavior is now
consistent with that of the mainframe.

01978959 (199001)

Micro Focus' ICETOOL emulation now sends carriage control characters in the LIST data set by default.
The RECFM of the LIST data set will be FBA. If NOCC is set, the carriage control characters are
suppressed and the RECFM of the LIST data set will be FB.

01685295 (97066)
There have been some performance improvements for files opened exclusively (i.e. DISP=OLD,
DISP=NEW, and DISP=MOD), in batch jobs running under Enterprise Server.

00780741 (101034)

The dbfhadmin utility has been enhanced to allow the integrity of a datastore to be verified, and
optionally, fixed up: use the dbfhadmin -verify -list]-recover options. See The dbfhadmin
Command Line Utility in your product Help for more information.

00778044 (90143)
The dbfhadmin command-line utility has been enhanced to provide the capability for verifying and
optionally repairing (cross-)region databases.

02123645 (193071)

The cross-region database heartbeat interval can now be configured using the dbfhconfig -add]-
update -heartbeat i nterval -in-seconds command. The default heartbeat interval remains as
5 seconds. A warning message is how output to the Enterprise Server console during region database
start-up if the heartbeat interval is configured to be >15 seconds. The larger the heartbeat interval, the
longer the time that is required to be able to recover (cross-)region database resources. Recovery can
only take place for a process if its associated heartbeat record has not heartbeat within the last
"heartbeat-interval + 5" seconds.

02155269 (202149)

The performance of PostgreSQL optimized 1/O has been improved. If you use the psqlodbc device
driver, you will need to ensure that you are running with version 12.02.0000 or later. This change has
been tested with version 13.01.0000. To take advantage of the performance benefits of this change,
specify BatchSize=100 for each of your ODBC DSNs. Using a version of the driver earlier than
12.02.0000 could result in a performance degradation when deploying large files to datastores.

(125032)

Table record locking and database record locking are incompatible and may lead to data corruption if
used together by separate processes when processing the same file. MFDBFH has been enhanced to
ensure that if a file is already opened in a process with table locking, all other processes attempting to
open the same file, even if requesting database locking, will also use table locking. However, if a
process has a file opened using database locking, other processes attempting to open the file will only
be allowed to do so if they are transactional files (i.e. database record locking can only be used for
transactional files). An attempt to open the file as non-transactional will fail. Refer to the Record Locking
Strategies documentation for more information.

(102011)
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 MFDBFH now enforces the existing requirement that a region database used by a PAC, or a region
database used by an ES region configured to use ES_LOCK_DB, is not used by any other PAC or
ES_LOCK_DB regions. This is necessary to avoid problems such as jobs with the same name
submitted to two separate regions, but erroneously using the same region database, from being blocked
by waiting on SYSZJOBD and/or SYSZJOBN ENQs. A check is now performed during region start-up to
ensure that the region database is not already being used by another region, If it is, the region start up
will fail, with error messages indicating the cause of the failure output to the ES console. Existing ES
PACs/regions will need to be stopped and restarted for these new region database state checks to take
effect. The dbfhadmin -region -status [-reset] command has been introduced to allow a
region database's state to be displayed and, optionally, reset. See Resource Locking in your product
Help for more information..

(121030)

JCL Support
Back to the list

» The User Exit event has been updated to contain the date and time of the job submitted when the job-
ready event occurred in the past. To make use of this functionality, you must recompile the CAS User
Exit Event Manager. See mfjdjevt.cpy for more information.

(177018)

« A new environment variable, ES JES ENFORCE_EXPIRE_DATE , has been added to determine
whether or not to check the expiration date when deleting a catalogued dataset, and if expired, delete
the dataset. If it hasn't expired and the PURGE option has not been specified, the dataset is not
removed. The PURGE keyword is required to delete non-expired datasets. PURGE removes the
underlying physical dataset file unless it is referenced by another catalog entry.SMS
MANAGEMENTCLASS now supports maximum RETAIN days. See the example of the %SMS
command in the Using SMS MGMT Classes topic in your documentation.The EXPDT entry in a DD
statement must be a four-digit year (YYYY); otherwise 1900 is the default, which is in-line with the
mainframe processing, and prevents unexpired datasets from being erroneously removed (as was the
case with the previous default of 2000).

3190103 00368441 (12368)

* A change in behavior of the evaluation of step COND CODES has been made. The new behavior is that
step ABENDS now take precedence over normal return codes. This corrects a problem that caused a
step that returned a higher decimal value than an earlier step ABEND code to take precedence and
become the job COND CODE.

02210859 (244066)

« It was possible to run a job without required enques. To correct this, an error now occurs at the start of a
job if the required enques are missing, and the job does not run.

02164345 (203249)

e SYSOUT datasets that were referenced in later steps were incorrectly marked as temporary, and
therefore 'PASSED' on in the job. This caused them to be deleted at the end of the job. To correct this,
those SYSOUT datasets are now 'RETAINED'.

00713567 (69460)
* The ALTER command now takes the TO and FOR options to enable specification of the retention period
for the entry being altered. The maximum retention period may be limited by the management class.

3190103 00368441 (12249)

e The IDCAMS LISTCAT command ALL parameter now generates a separate HISTORY report that
shows the creation date time and job, the last changed date time and Job, and the expiration date.A
new environment variable, ES_JES_LISTCAT_YMD, has been added to determine the date format used
in the HISTORY report generated when the IDCAMS LISTCAT command specifies the ALL option.

3190103 00368441 (11429)
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The validation of configuration settings used by JES has been improved, together with more detailed
error messages.

02041040 (165046)
Support for DSENQSHR has been added to JES via the ES_DSNQSHR environment variable. See the
ES_DSENQSHR topic in your product documentation for full details.

01818520 (111002)

Two new spool housekeeping performance options, USE_DISK_HK and

DISABLE_LOCK FOR_BULK_ DELETE, have been added to enable spool housekeeping to be
processed on a local disk instead of the server. See Configuring the MVSSPLHK Housekeeping
Process in your product Help for more information.

00367284 (79030)

GDG model support has been updated to support the assignment of an empty subdirectory value in the
allocation override configuration (see the JCL - Allocation Override sample in the Mainframe Samples
Browser).

02177846 (209041)

In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not
validated for user access. This has been corrected. If the user does not have permission to access
(READ) the dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient
authority to read dataset '<DATASET NAME>'" is written to the SYSTSPRT. A message is also written
to the job log: "™*MSG User not authorised to access SYSEXEC <DATASET NAME>". This fix might
require updates to the DATASET access rules.

02144158 (248013)

In a security-enabled region, the dataset containing a REXX or TSO command was not validated for
user access. This has been corrected. If the user does not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
dataset '<DATASET NAME>"" is written to the SYSTSPRT. This fix might require updates to the
DATASET access rules.

02144158 (208030)

A problem that erroneously caused some user-supplied parameters to translate from EBCDIC to ASCII
when calling DSNRLI has been corrected. The dsnr i .cpy copybook and dsnrli . inc PL/I include
file have been revised to have the full declaration of ACCOUNT-STRING. You must recompile
copybooks that use either of these modules.

(161065)

The JCL spool file has a new format. Starting with this release, you must use the mfsplcnv tool to
convert spool files created using a previous release from the old format to the new. See Spool Files and
mfsplcnv Spool Conversion Utility in your product Help for more information.

(113011)

An excess of 999 duplicate DD statements per step caused a hang in JCL processing. This has been
corrected and an error message indicating that this number has been exceeded is now generated
(JCLCMO0640U).

00775329 (90002)

The new MFJ_LEX_LOCATION JCL environment variable enables you to specify an alternative location
for the storage of JCL lexigraphical files, which are created when a job is parsed, and stored in the
same directory as the job log by default. The alternative directory location must be accessible by all
regions that both submit and run jobs.

(116002)

The layout, including the position of fields, in the IHAPSA_MAC and IKJTCB .MAC copybook files used to
hold information for the JCL control blocks for PLI programs has changed. To apply this fix to existing
applications, recompile and validate all PLI programs that include these copybooks.

(105043)
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* MFFTP now converts from EBCDIC to ASCII in PUTs and from ASCII to EBCDIC in GETs, for files
cataloged as EBCDIC when a TYPE A or ASCII sub-command is issued and when the new
environment variable MFFTP_ASCII_CMD_XLATE is set to Y (default is N).

02157927 (202176)

« JCL job behavior has been updated to address an issue that caused the generation of a //SYSIN entry
when non-JCL statements, such as blank lines, preceded the first step. The generated //SYSIN entry
is now marked as invalid, and a JCLCMO0642U parsing error is issued.

00368443 (11497)

Machine Administration
Back to the list

* A problem with using the .NET 3.5 framework has been fixed.

(204144)
* A problem with CPU conversion has been corrected.

(199042)

Mainframe Access
Back to the list

* Previously when authenticating with the mainframe, login failure messages provided too much
information which could potentially be exploited for username enumeration. Login failure messages will
now only state that invalid credentials were provided. This applies to MFDAS, MFDASMX, Mainframe
Explorer in Eclipse and Visual Studio, MVS Explorer in Eclipse, and SyncMon.

01868545 (119073)

Micro Focus Communications Server

Back to the list

« When an enterprise server region is configured to use External Security, access to the Communications
Server's "statistics" Web page is now restricted, just as access to the Communications Server log is. To
permit access to this page for secured enterprise servers do one of the following:

« Disable Communications Server control listener security by adding the following to the
Configuration Information field for the communications server:

[security]control listener=nolnstruct

Users must provide Enterprise Server credentials when prompted. This can occur when you attempt
to view the page, and when Allow unknown resources is checked in the region security
configuration (use this with caution)

< Add a resource security definition named "Statistics" to the "Communications Server" class, with an
ACL that grants READ permission to those users who should have access to the page

00368582 (11442)

Micro Focus Batch Scheduler Integration
Back to the list

« The Micro Focus Batch Scheduler Integration (MFBSI) no longer hangs while waiting for a response
from the license manager.

02006571 (162055)
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Micro Focus Directory Server
Back to the list

- The mfds /s option supports the specification of the optional Enterprise Server user id and
password parameters using a configured Micro Focus Vault Facility location rather than using literal
strings for credentials. For example:

mfds /s 1 mfsecret:user/user_001/id mfsecret:user/user_001/pwdwhere user/
user_001/i1d and user/user_001/pwd

Are secrets stored in the default-configured vault. These values can be populated and administered
using the mFsecretsadmin utility. See Vault Facility in your product Help for more information.The
mfds /x and /g command-line options also support credentials stored in the vault.

02131532 (193088)

« If MFDS is configured to store sensitive values in the vault (for example, XA openstring or autostart
credentials), these values were not being included in legacy data format or XML export of Enterprise
Server configuration information. Subsequently, these values could not be reimported. These sensitive
values are now included in the exported data. Micro Focus recommends that you protect the exported
files with appropriate access control.

(202272)

PL/I Support
Back to the list

« Previously, if STRINGRANGE had been enabled by the -prefix stringrange compiler option, and
a user program did not contain an ON STRINGS1ZE statement, there was no message printed out
indicating that STRINGRANGE had been triggered. The message now appears in this scenario.

00696776 (73031)
* Nested TYPEs (TYPE of TYPES) are now supported.

00366179 (11649)
« Nested LIKEs (LIKE of LIKES) are now supported.

00366181 (13419)
* A problem that prevented the CONTROLLED parameter from displaying correctly in the compiler listing
has been fixed.

01916288 (130002)

« The compiler listing file has been updated to provide enhanced output when the -xref compiler option
(cross-reference listing) is in effect. The listing file now indicates which variables and other identifiers,
such as procedures and labels, are unreferenced, and where they are declared. This helps you to
eliminate unnecessary declarations, thus reducing storage requirements and improving code readability.
Where a member of a structure is referenced, this flags the entire structure as referenced. External
variables and procedures are not flagged as unreferenced. To accommodate include files, the
nomenclature for a definition (DEF) or reference (REF) in the cross-reference listing is a number of the
form n. m where n is the line number and m is a file identifier. A list of file indenters and corresponding
file names is generated at the end of the cross-reference listing.

02159460 (203162)

« The compiler listing file has been enhanced to indicate which variables and other identifiers, such as
procedures and labels, are unreferenced, and where they are declared. This helps you to eliminate
unnecessary declarations, thus reducing storage requirements and improving code readability. Where a
member of a structure is referenced, this flags the entire structure as referenced. External variables and
procedures are not flagged as unreferenced. To accommodate include files, the nomenclature for a
definition (DEF) or reference (REF) in the cross-reference listing is a number of the form n.m, where nis
the line number and m is a file identifier. A list of file indenters and corresponding file names is
generated at the end of the cross-reference listing.
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01858879 (120030)

* An application doing a WebSphere MQ SIGNON caused an invalid result from a PL/l exponentiation
calculation if WebSphere MQ was using a locale other than C/Posix. This has been corrected for the
de_DE or derivative locale.

01991479 (155012)
» 1/O directed by PUT LIST now uses BX format for type OFFSET.

(195051)

e A problem with PLIDUMP prevented control from being returned to the ON ERROR after completing the
dump when PLIDUMP was driven with the H option from an ERROR on unit that had established ON
ERROR SYSTEM. This has been fixed.

02134496 (194112)

* The dumping of H(eap) memory in a PLIDUMP now checks for patterns of three or more identical lines
and issues a "same as above" message indicating the memory range instead of printing the entire
batch of lines.

02160703 (204151)

* When using the PLIDUMP facilities H option on a system that had an artificial limit on maximum file
sizes, an infinite loop sometimes occurred if that maximum file size was reached. This has been
corrected. The PLIDUMP is now truncated at its maximum allowed size.

02162046 (203155)
» Previously, when using PLISAXA, the document length as driven to the Start of Document event was
incorrect if the XML document contained characters that exceeded hex 7F. This has now been fixed.

00381945 (61228)

e A new built-in function. SQRTF, has been added to generate an ERROR condition if its condition
operand is negative. The SQRT function has been updated to do the same. Previously, SQRT
sometimes returned a floating-point NaN.

(193100)

* In previous releases, FIXEDOVERFLOW was not raised when an attempt was made to assign a value
to a FIXED DECIMAL variable that was too large, causing the value to be truncated. The behavior has
been changed to raise an error if FIXEDOVERFLOW is not present.

02163371 (204181)

e The PL/I run-time system has been enhanced to honor the READ FILE(xx) IGNORE(x) syntax for
sequential files.
02047425 (183067)

« The OPTIONS(NOEXECOPS) attribute of a procedure statement is no longer ignored, but is now
honored for programs running under the control of JCL.
3238380 (11686)

« A new feature, PL/I data breakpoints has been added. A data breakpoint breaks execution when a
specified memory location is written. Use of data breakpoints assumes expert-level knowledge of how
memory works, how variables are allocated, and how data is written to memory. For complete details,
see the Using Breakpoints topic in your product documentation.

00370003 (12178)

REXX Support
Back to the list

* In a security-enabled region, the REXX SYSEXEC or SYSPROC dataset used by IRXJCL was not
validated for user access. This has been fixed. You do not have permission to access (READ) the
dataset, an S913 security violation abend is generated, and "MVSAF0222S Insufficient authority to read
dataset '<DATASET NAME>"" is written to the SYSTSPRT. A message will be written to the job log:
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"*MSG User not authorized to access SYSEXEC <DATASET NAME>".Note: This fix might require
updates to the DATASET access rules.

(247033)

» EXECIO * DISKW was stopping on the first line containing no characters, writing out no further records.
Now after encountering an empty record, a line with only a linefeed is written and processing stops.

01991499 (158007)

Run-time System
Back to the list

e The native COBOL multi-threaded demo is now available for Windows development products.

(3765)
« Basic support for xterm-256color has been implemented.

(57591)

SQL: OpenESQL
Back to the list

« A performance problem in a SQL program using fixed-length character arrays when compiling a COBOL
program and using array fetch has been resolved.

02152406 (203060)

« A new feature to assist migration between databases has been added. SQL error codes and messages
may be mapped to different values or supressed to match those expected by the application.

(193003)

Known Issues

Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.
In addition, note the following:

« Problems with Microsoft's Visual Studio 2022, release 17.2, might cause the following issues with Visual
COBOL or Enterprise Developer for Visual Studio 2022. The issues do not exist in release 17.1. See
the points below for the workarounds to these issues:

* Anissue with Microsoft's Visual Studio installer might result in the IntelliSense and editor colorization
not working. To repair your installation, execute the following command from a Visual Studio
command prompt:

devenv /updateconfiguration

This issue is resolved by Microsoft in Visual Studio 2022, release 17.3. You need to update your
Visual Studio installation.

« Mixed-language multi-project builds might fail as a result of the project dependencies not working
correctly. This means that some projects might build in parallel when they should build in a specific
order. As a result, the build might fail due to a dependency not always being available. To work
around this issue, click Tools > Options > Preview Features, and check Load projects faster
(some features may be delayed).

This issue is resolved by Microsoft in Visual Studio 2022, release 17.3. You need to update your
Visual Studio installation.

» The expanded copybook visualizations are missing. This includes breakpoint, current statement
when debugging, and others. These features might not always function correctly in non-expanded
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source (in the main programs) if that program contains expanded copybooks. To work around this
issue, you can disable inline copybook expansions.

Visual Studio 2022 requires that the global . json file of .NET 6 projects is placed at the directory
level of the solution file in order for the project to successfully open and build. In previous versions of
Visual Studio, the file could be located in subfolders of the solution such as in the project folder.

This can affect existing .NET Core 3.1 COBOL projects that you upgrade from a prior release if the
global . json file is not at the directory level of the solution file. It also affects .NET 6 COBOL projects
that you add to an existing solution.

In these cases, you might receive the following error message if building from the MSBuild command
line, or in the IDE Output window if the project fails to load:

"The SDK “MicroFocus.Sdk" specified could not be found"

To work around this issue, you need to move the global . json file to the directory level of the solution
file.

New .NET 6 COBOL solutions and projects created with VS2022 create the global . json file in the
required location.

It is not possible to upgrade from a 7.0 version of the Visual Studio-based product, if you are targeting a
different version of Visual Studio. For example, it is not possible to upgrade from Visual COBOL 7.0 for
Visual Studio 2017 to Visual COBOL 8.0 for Visual Studio 2019.

It is not possible to install the 8.0 version of COBOL Server or the Visual COBOL Build Tools as an
upgrade of an existing 7.0 installation of the respective product. You must first uninstall the 7.0 product.

The Server Core form of Windows Server 2019 is not supported.

In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.

The ChangeMan Attachment models of release 5.0 and earlier are not working in the expected manner
under Enterprise Developer 8.0. This is a result of several tools that are called with a static value="*"in
the input parameter CMG_PROP_STATIC_SUBSYSTEM. If you want to run a ChangeMan attachment
model 5.0 and earlier under Enterprise Developer 8.0 you must remove the static value="*" from all
CMG_PROP_STATIC_SUBSYSTEM input parameters.

Installation

System Requirements
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Hardware Requirements

In general, most modern machines will have the required processor and available RAM to run the Micro
Focus products under Windows effectively. For planning purposes, you should consider having a minimum
of 2GB of RAM though Micro Focus recommends at least 4GB of RAM for optimal performance.

Visual COBOL and Enterprise Developer for Visual Studio

Visual COBOL and Enterprise Developer have the following requirements in addition to the requirements of
Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

Product Maximum Disk Space Sentinel RMS License Manager
Requirements

Visual COBOL 1.2GB 75MB

Enterprise DeveloperEnterprise 2.3GB 75MB

Developer

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Visual COBOL and Enterprise Developer for Eclipse on Windows

The disk space requirements are:

Product Maximum Disk Space Sentinel RMS License Manager
Requirements

Visual COBOL 3.7GB 75MB

Enterprise Developer 4.5GB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL or Enterprise Developer on a 64-bit operating system, you can
produce either 32-bit or 64-bit applications.

For a list of the operating systems each individual product in this package supports, check the Supported
Operating Systems and Third-party Software section on the Micro Focus Customer Care Web site. For
example, https://www.microfocus.com/documentation/enterprise-developer/ed80/ED-Eclipse/
GUID-7ECA1D86-EC87-454D-B666-1047527FD9BF.html.

Software Requirements
i Note: This product includes OpenSSL version 1.1.1n-mf6 (modified).

Windows

Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.
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Visual COBOL and Enterprise Developer for Visual Studio:

You must have Microsoft's Visual Studio 2017 version 15.9 or a newer one, or 2019 version 16.11 or a
newer one, or 2022 version 17.0 or a newer one installed in advance. SQL CLR in Visual Studio 2022
requires version 17.1 or newer.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition (for Visual Studio 2017) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2019) - see the next section for the
Visual Studio components you must install.
Professional, Enterprise or Community Edition (for Visual Studio 2022) - see the next section for the
Visual Studio components you must install.

Microsoft's Visual Studio Express Edition is not supported.
/1, Important:

« When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

* Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Visual COBOL and Enterprise Developer for Eclipse:
The following requirements apply to both Visual COBOL and Enterprise Developer:

e A 64-bit Windows is required. Visual COBOL installs fully only on 64-bit Windows platforms. On 32-bit
Windows, the setup file does not install some of the components. See Issues with the Installation in
Known Issues and Restrictions.

* The setup file installs Visual COBOL and the 64-bit version of Eclipse 4.20 (2021-06).

Visual COBOL only supports the 64-bit version of Eclipse. You can use the 64-bit Eclipse to create both
32-bit and 64-bit applications.

* The setup file installs Adoptium's OpenJDK Temurin 11.

* The setup file also installs Microsoft's Visual C++ 2012 and 2017 Redistributables.

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

e Java 11 (64-bit) is required to run the Eclipse IDE. The minimum recommended version is Adoptium's
OpenJDK Temurin 11 (LTS) with HotSpot, which the Windows product installs automatically. You can
download Adoptium's OpenJDK Temurin 11 (LTS) with HotSpot from Adoptium's Web site and unpack
the archive anywhere on your machine.

» Visual COBOL requires a 64-bit Java installation to run a 64-bit Eclipse.

« Microsoft Windows SDK and Microsoft Build Tools: Various actions and operations within your COBOL
development environment depend on certain files that Microsoft distributes in the following packages:
the Windows SDK package and the Microsoft Build Tools package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.

If you need to use any other version of these packages, or use them installed to a non-default location,
use the cbIms command line utility post-installation to manage this; see Managing the Microsoft Build
Tools and Windows SDK Packages for more information.
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Installation Restrictions and Requirements

Before starting the installation you should be aware of the following:

* Visual COBOL and COBOL Server cannot coexist on the same machine.

« Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE
(Visual Studio or Eclipse) you install.

« You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

« If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

* You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

Downloading the Products

Installing the Products

Use the individual setup files to install each product from the Micro Focus Academic Program package as
follows:

Windows

1. Run the pr oduct name .exe file and follow the wizard instructions to complete the installation.

2. After installing the Visual Studio 2022 product, you need to execute the following command from a
Visual Studio command prompt:

devenv /Zupdateconfiguration

This fixes an issue with Microsoft's Visual Studio installer in Visual Studio 2022, release 17.2.n, that
might result in the IntelliSense and editor colorization not working.

After Installing

Visual COBOL and Enterprise Developer for Visual Studio

You are now ready to run Visual COBOL or Enterprise Developer. You need to start the version of Visual
Studio for which you have installed this product. By default, the Help is available online on the Micro Focus
SupportLine Web site: https://www.microfocus.com/support-and-services/documentation/.

To see the Help:

e Click Help > Micro Focus Product Help > Product Documentation.
« Alternatively, press F1 inside the editor or from a Ul part.

This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the Ul you are querying.

Note: Your Visual Studio might be configured to show the local help. To switch to online help, click
Help > Set Help Preferences > Launch in Browser inside Visual Studio.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.
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Visual COBOL and Enterprise Developer for Eclipse

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the perspective you
are working with after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.

2. Make sure you are in the perspective you need to reset by clicking Window > Perspective > Open
Perspective > Other.

3. From the Open Perspective dialog box, click the perspective you want to reset.

4. Click OK.

5. Click Window > Perspective > Reset Perspective.

6. When prompted, click Yes.

7. Reapply any customizations.

To view the help:

* Click Help > Micro Focus > Product Documentation.
« Alternatively, press F1 inside the editor or from a Ul part.

This opens a browser with the Visual COBOL help.

Note: By default, Eclipse is configured to show the local help. See the installation notes within the
product Help, for instructions about how to switch to local help.

Refer to the Welcome and Product Information sections in your product Help. Here, you will find information
on getting started including tutorials and demonstration programs.

Repairing

Windows

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

UNIX

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling

Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
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packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Visual COBOL, Enterprise Developer, Enterprise
Server for .NET, and Micro Focus License Administration. Uninstalling only Visual COBOL does not
automatically uninstall Enterprise Server for .NET, the Micro Focus License Manager or any of the
prerequisite software.

Enterprise Server for .NET must be uninstalled before you remove Visual COBOL. To completely
remove the product you must uninstall the Micro Focus License Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

e Micro Focus Product Nane folder in the Start menu - you can delete it manually.

* Ysystemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log
files of the samples which you have built.

* %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.

* %Program Files%\Micro Focus - you can delete it manually.

Copyright and Disclaimer

© Copyright 2022 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS 1S" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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